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REFERENCE TO EC STATEMENT OF CONFORMITY

This document confirms that products manufactured by
Duran Audio bearing the CE label meet all the requirements
in the EMC directive 2004/108/EC and LV directive 2006/95/
EC laid down by the Member States Council for adjustment
of legal requirements. Furthermore the products comply
with the rules and regulations from 30 August 1995
referring to the electromagnetic compatibility of devices.
Duran Audio products bearing the CE label comply with the
following harmonised or national standards:

EMC:
EN 55103-1 :1996
EN 55103-2 :1996

Safety:
IEC 60065 :2002

Mains Harmonics:
EN 61000-3-2 :2001

Insulation:
Class1

Duran Audio BV
Koxkampseweg 10
5301 KK Zaltbommel
The Netherlands

Tel: +31 418 515583
Fax: +31 418 518077

Zaltbommel, December 2011.

USER’S NOTICE AND DISCLAIMER:

No part of this manual including the software described in
it may be reproduced, transmitted, transcribed, stored in a
database system or translated without the express written
permission of Duran Audio BV.

Documentation kept by the end user for back-up purposes
is excluded from the above.

All products and corporate names mentioned in this
manual may be registered trademarks or copyrights of their
respective companies. They are used here for indicative
purposes only.

The information contained in this manual has been carefully
checked for accuracy; however no guarantee is given with
respect to its correctness. Duran Audio BV accepts no
responsibility or liability for any errors or inaccuracies that
may appear in this manual or the products and software
described in it.

Specifications and information contained in this manual

are subject to change at any time without notice.

© 1998-2011 Duran Audio BV. All rights reserved.
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1.IMPORTANT SAFETY INSTRUCTIONS

This symbol is intended to alert you to the
A presence of uninsulated dangerous voltages
within the product’s enclosure that may be
of sufficient magnitude to constitute a risk of

electric shock.

This symbol is used throughout this manual

A

1) Read these instructions.

and is intended to alert you to the presence of

important instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this apparatus near water.
6) Clean only with dry cloth.

7) Do not block any ventilation openings™. Install in
accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators,
heat registers, stoves, or other apparatus (including
amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarised or
grounding-type plug*. A grounding-type plug has two
blades and a third grounding prong. The wide blade or the
third prong are provided for your safety. If the provided
plug does not fit into your outlet, consult an electrician for

replacement of the obsolete outlet.

10) Protect the power cord from being walked on or
pinched particularly at plugs, convenience receptacles, and
the point where they exit from the apparatus*.

11) Only use attachments/accessories specified by the
manufacturer.

@ 12) Use only with the cart, stand, tripod, bracket
.22 | or table specified by the manufacturer, or sold with

the apparatus. When a cart is used, use caution

when moving the cart/apparatus combination to avoid
injury from tip-over.

13) Unplug this apparatus during lightning storms or when
unused for long periods of time*.

14) Refer servicing to qualified service personnel. Servicing
is required when the apparatus has been damaged in any
way, such as power-supply cord or plug is damaged, liquid
has been spilled or objects have fallen into the apparatus,
the apparatus has been exposed to rain or moisture, does
not operate normally, or has been dropped.

f Warning -To reduce the risk of fire or electric
shock, do not expose this apparatus to rain or

moisture and objects filled with liquids, such
as vases, should not be placed on this apparatus.

C Warning - To disconnect this apparatus from
the mains power supply, turn off the power at

the switch labelled Circuit Breaker on the front
panel of the amplifier and remove the connector from the
mains input socket labelled Mains on the rear panel*.

é Warning - the PowerCon® connector should
never be plugged or unplugged when there is

power on the connector, regardless of whether
the amplifier is switched on or not. ALWAYS ensure that
the mains supply is turned off at source before inserting
or removing the PowerCon®*.

Warning - This apparatus is a Class | device and
A must be connected to a mains socket outlet that
provides a safety ground connection®.

Warning - The installer should ensure that the
A mechanical mounting method employed for

the loudspeaker column should be capable of
supporting four times the weight of the unit (i.e., with
a safety factor of 4x). Always use both the brackets
provided with the unit.

* These safety warnings are applicable to the IntellliAmp amplifier only
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2.INTRODUCTION

This manual describes the recommended installation
procedure for the AXYS® Intellivox DC (DDC2.0) and DS
(DDS) range of loudspeakers, Models DC/DS 808 and 1608.

The AXYS® Intellivox is a type of loudspeaker known as
an active DSP-controlled loudspeaker array, which utilises
the principle of mounting multiple, individually-driven
loudspeaker drive units in the vertical plane at specific
spacings. All the Intellivox models covered by this manual
consist of two components: the column loudspeaker unit
and a mains-powered multi-channel power amplifier which
includes a Digital Signal Processing (DSP) section.

The DC/DS 808/1608 models have been specifically
designed for applications where a high SPL is required,
and/or an extended audio frequency response suitable for
high quality music reproduction is desirable.

This manual describes the following aspects of an
installation:

e Necessary cabling
e Connector wiring

e Mechanical installation

A

describes this procedure. (Note that full configuration

After installation, the amplifier and
loudspeaker should be tested for basic
functionality using the supplied AXYS®
WinControl software; the manual also

and control of the loudspeaker is beyond the scope of this
manual; this topic is fully documented in the WinControl
Help files.)

APPLICABLE MODELS, AND VARIANTS

This manual applies to the following AXYS® Intellivox
models*:

Intellivox-DC808 and DC1608

Intellivox-DS808 and DS1608

Note that later serial numbers are equipped

A with an input board with Phoenix in stead

of WAGO connectors. This manual describes the WAGO
version (early serial numbers). The Phoenix input board is
used from the following serial numbers:

lvx-DC808 : 011600013
lvx-DC1608 : 011700010
Ivx-DS808 : 010700016

lvx-DS1608 : 010800036

The DC/DS808 loudspeaker unit is fitted with six 6.5" lo/
mid-range drivers and two 1" hi-frequency compression
drivers. The DC/DS IntelliAmp supplied with these models
has 8 separate audio channels.

The DC/DS1608 loudspeaker unit is fitted with fourteen
6.5" lo/mid-range drivers and two 1" hi-frequency
compression drivers. The DC/DS IntelliAmp supplied with
these models has 16 separate audio channels.

The DS models use a different DSP algorithm from the DC
models. This difference may be ignored for the purposes of

installation and commissioning.

DC/DS 1608 DC/DS 808

fig.1 The Intellivox models covered by this manual

*Other members of the Intellivox range, including DC/DS 115 and DC/DS/DSX 180, 280, 430 and 500 models have different
installation procedures and this manual should NOT be used when installing them. Refer instead to Intellivox Installation

Manual Ref. 2008 10/lvxIM_v2.0.
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WHAT'S IN THE PACKAGING

The Intellivox is shipped in two separate shipping cartons: the loudspeaker unit and the amplifier/DSP section.
Loudspeaker:

In addition to the loudspeaker itself, each unit is shipped with the following items:

¢ Two mounting brackets, pre-attached* to the loudspeaker
e Box containing speaker cable (5 m), fitted with 20-way (DC/DS808) or 40-way (DC/DS1608) Harting connectors at each
end (male-to-female)

Amplifier:
In addition to the IntelliAmp itself, each unit is shipped with the following items:

e |Installation manual (this document)

¢ Datasheet specific to the model

e AC power cable (2 m), fitted with a Neutrik® PowerCon® connector and a European mains plug
e Package of small parts, consisting of:

REF ITEM QTY USE
A M8 x 45 mm hex-head screws with washers and wall plugs 8 Mounting bracket fixings* (wall)
. Mating connector for rear panel
B 5-pole female WAGO connector, with cover 1

RS-485 control port

Connector for front panel

C 5-pin XLR male connector 1 RS-485 interface
. Mating connector for rear
D 6-pole female WAGO connector, with cover 1 .
panel audio inputs
E F Set of PVC inserts for WAGO connectors, with wire insertion tool 1 WAGO connector wiring

i,

W/ s v W
A B i
fig.2 - Box _Z
contents
E

*The mounting brackets are fitted to the loudspeaker at the factory in order to provide protection during shipment of the
HF compression drivers.

201112/lvxHPIM_v1.1
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3. INSTALLATION GUIDE

PREPARING FOR INSTALLATION

Before starting to install the Intellivox loudspeaker, a
number of points should be considered.

e |t is assumed that the installation site has been the
subject of an extensive DDA investigation or optimisation
prior to the actual install. (DDA = Digital Directivity Analysis,
the AXYS® proprietary simulation and optimisation software
for these products*). This procedure will have identified the
optimum physical location for the Intellivox loudspeaker,
to accurately achieve the desired acoustic coverage. In
particular, the “acoustic centre” position will have been
specified, in terms of height above the finished floor. The
installer should confirm that he/she has this information.

o Unless specified otherwise by the sound system designer,
the Intellivox column should be installed at a position exactly
perpendicular to the listening plane (i.e. vertical if the floor is
horizontal). Unlike conventional loudspeaker systems, minor
mechanical misalignment may lead to degraded coverage
and intelligibility. Ensure (by use of a levelling device such
as a spirit level) that the surfaces to which the mounting
brackets will be attached are absolutely vertical and in
the same plane, and that all the individual fixing holes are
themselves in the same plane.

e The only electrical connection to be made to the
Intellivox loudspeaker is the multicore cable from the
amplifier. Consideration should be given to its cable route
and also to ease of rear access to the connector. The Harting
connector is quite large and allowance for its size needs to
be made when preparing the mounting location.

e The separate IntelliAmp is intended to be mounted in a
standard 19" rack; this should be as near as practical to the
loudspeaker column. The standard speaker cable supplied is
5 min length, but longer versions, up to 25 m, are available
to special order; please contact JBL for more information.
The amplifier operates from 230 V as well as 115 V AC
mains; a suitable AC mains outlet will be required at the rack
location. The outlet must be on a circuit able to supply the

full-load current and the maximum short-term in-rush current
drawn by the amplifier. Refer to the datasheet supplied for
the actual figures specific to the model being installed. The
third terminal of the mains outlet must be connected to a
proper safety ground. Local safety regulations may require
a separate mains distribution network or an uninterruptible
mains power supply (UPS).

SIGNAL AND CONTROL CABLES

REQUIRED CONNECTIONS

Audio  Rs-485 ACMains

supply ) )

> 2 0

l \ 1 via @

Harting

- q connector - -

Amplifier J @

et B (O]

Ol o0 —— S
External :

Ambient noise Failure Relay @

+ Temperature ]

sensor @

OPTIONAL CONNECTIONS —

fig.3 - Connections

¢ |n addition to the mains supply and the multicore cable
to the loudspeaker, some or all of the following cables will
need to be run to the rack location. The necessity for each
of these will have been determined by the system designer;
the installer should ensure that he/she has these details to
hand. All wiring details can be found on pages 9-15.

e Network connection: the IntelliAmp is configured, and
may also be monitored, from a PC running AXYS® WinControl
software. With all installations it will be necessary to upload
the correct settings for each unit (loudspeaker/amplifier
combination) to obtain the desired acoustic coverage. Once
this has been done, there is strictly no longer an operational
need to have the IntelliAmp connected to a PC because all

*Authorised electro-acoustic consultants or ‘build & design’ sound contractors can apply for a DDA License free of charge.
This license can be obtained through our website at http://www.duran-audio.com/
For further information please refer to the Help files and manual with the DDA software.

201112/lvxHPIM_v1.1



settings are stored locally within the unit's memory and in
the event of a power failure will be automatically reloaded
on power-up. The system designer will have determined
whether a permanent network connection needs to be
provided. This will be the case if the Intellivox is to be
monitored remotely during normal operation. Otherwise,
the network wiring can be omitted, but consideration should
still be given to the amplifier's location with regard to ease
of both initial and future access for a PC connection. It may
be appropriate to install network wiring in order to provide
a network access point at a location more easily accessible
than at the rack. A cable with two individually foil-screened
twisted pairs should be used. Details of suitable cables can
be found at page 23.

e Audio inputs: the IntelliAmp accepts line level audio (0
dBV)*. Two separate transformer-balanced audio inputs
are provided; however, units are shipped with only input 1
active. Input 2 can be made active via WinControl.

¢ Fault monitoring: if network monitoring is not to be
used, a simple surveillance function may be realised by
means of the IntelliAmp’s “failure detect’ volt-free relay. This
connection requires a 2-core cable.

¢ Ambient Noise Sensing: the DSP section of the IntelliAmp
incorporates an autogain algorithm which can adjust the
gain of the system in response to changing ambient noise
levels. If this feature is to be used, an external ambient
microphone (available as an option**) should be connected
if specified by the system designer. Standard screened two-
core microphone cable should be used for this purpose.

e Frost protection: The IntelliAmp is equipped with a frost
protection system which activates an internally generated
pilot tone if the ambient temperature drops below a pre-
determined threshold. The frost protection threshold can be
set using WinControl. If this function is required, an external
ambient temperature sensor (available as an option**)
should be connected with screened two-core cable (or
similar) for its correct operation.

AXYS® Intellivox 808/1608 Installation Manual Rev 1.1

MECHANICAL INSTALLATION OF THE AMPLIFIER

The IntelliAmp is designed to be mounted in a standard 19"
equipment rack. The front panel is fitted with rackmount ears
for this purpose. The IntelliAmp occupies 3U of vertical rack
space.

Note that due to the weight of the amplifier,

the use of additional rear supports is strongly

recommended. The rear of the unit has additional
mounting points to facilitate this.

Ventilation

The IntelliAmp is forced-air cooled by two internal
temperature-controlled fans. This ventilation method should
ensure that the amplifier remains within its operational
temperature range under most circumstances, but if it is to
be installed in a location of high ambient temperature, and/
or in a rack containing a significant quantity of other heat-
generating equipment (see below), consideration should be
given to climate-controlling the room in which the equipment
rack is situated.

A

heat (e.g. another power amplifier). Plain 1U blank panels

Do not install the IntelliAmp in a 19" rack
immediately above or below another item of
equipment generating a significant amount of

should be used as spacers. Note that slotted or perforated
ventilation panels should not be used, as these will reduce
the effect of forced-air cooling. Also, be aware of the rear-
to-front direction of airflow of the IntelliAmp ; it is not good
practice to install equipment employing forced-air cooling
with different directions of airflow in the same enclosed rack.

A\

obstructions within 100 mm (4") in order to maintain the

Airflow is via the grilles at the rear (intake) and
front (exhaust) of the amplifier. Ensure that
both sets of grilles are completely clear of any

necessary airflow.

See page 16 for details regarding the mechanical installation
of the loudspeaker enclosure.

* The IntelliAmp may be ordered with alternative input modules which accept signals directly from 70/100 V distribution
systems. Two modules are available: a) with one normal 0 dBV balanced line level input and one 70/100 V input, b) with two
70/100 V inputs. These options need to be specified at the time of ordering. See page 22 for order codes.

**Note that the optional external ANS microphone is combined with a temperature sensor in a single unit (JBL Order Code
97661101). If both functions are required, the use of 2-pair screened cable is recommended.

201112/lvxHPIM_v1.1
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CONNECTOR AND WIRING DETAILS

All permanent connections to the IntelliAmp are made
at the rear of the unit. Audio 1 and RS-485 connections
are replicated on the front panel on XLRs, together with
loop-through connectors. This is useful when multiple
IntelliAmps are installed in the same rack.

12

1 Status LED 7 Fault monitoring
Mains Circuit Breaker relay connector

RS-485 loop-through 8 RS-485 connector
connector 9 Ambient SPL/

. temperature sensor
4 Alternative RS-485 connector
network connector

5 Audio 1 loop-through 10 Audio Input connector

connector 11 Loudspeaker connector
6 Alternative Audio 1 12 Mains connector
input

fig.4 - Connector Details

AC MAINS

The IntelliAmp is equipped with a 3-pin PowerCon® mains
connector. Internal mains current protection is
A provided by the resettable circuit breaker on the
front panel, which also acts as the mains on/off
switch. Be sure that the mains voltage stated on the unit
complies with the local standard before connecting the
IntelliAmp to the mains supply.

201112/lvxHPIM_v1.1

A 2 m pre-made PowerCon® mains cable with a European
plug is supplied with the unit. If it is necessary to fit a
different type of mains plug, please observe the following
cable colour codes:

TERM EURO USA

L Brown Black
E Green/yellow Green
N Blue White

The orientation of the PowerCon® connector is evident
from the keyway on the centre spigot; insert the plug fully
and then rotate it clockwise until a firm click is heard.
The plug is now locked against inadvertent removal. To
unplug, press the release latch on the side of the plug body
before rotating anticlockwise.

The PowerCon® connectors are plugged and unplugged as
shown in the diagram below.

Plugging in

Unplugging

fig.5 - PowerCon®

A\

mains is present. This applies whether or not the amplifier

Note - The PowerCon® connector should
NEVER be plugged in or unplugged while AC

is switched on. ALWAYS isolate the AC mains supply at its
source before plugging or unplugging the connector.

A Warning - This apparatus is a Class | device and
must be connected to a mains socket outlet that

provides a safety ground connection.

A Warning - Presence of mains voltage is not
indicated by the LED on the front panel. This LED

indicates the status of the IntelliAmp and cannot be used

as a mains voltage indicator.



WAGO CONNECTORS

All other Intellivox connections are made via the four on-
board WAGO Type 231 multi-pin connectors. These are:

¢ Audio (6-way male)
e Network (5-way male)
e Ambient noise mic/Ext. temp. sensor (5-way female)

e Failure detection (5-way female)

Failure Detect

Fan Relay
‘ 1 [u}
DG
coM [(©]H
NO K@ iy Y o
ne J(© L2
+24v (@Y A
@M |
G2
mc G4 S
I “Z
NTe |(© 1 ;ff:g
AN [(©] 13
GND |(© =
— | +1
Ambient Noise
Tem perature

fig.6 - Wiring Diagram

One 5-way and one 6-way mating female connector
is supplied with every unit for the network and audio
connections. 5-way mating male connectors for the other
two sockets are available separately from JBL if required
(see page 22), but will be shipped with the unit if specified
at the time of order.

To wire the WAGO Type 231 connectors, proceed as
follows:

1) Prepare the cable; strip back approximately 8-9 mm
(0.35") of the insulation of each core.

2) Refer to the table opposite: select the appropriate
PVC insert for the wire size. If the wire is too big for the
largest size insert, the inserts can be ignored and the wire
connected directly (next step). Insert the wire into the
insert so that the bare end goes through the hole but the
insulated portion does not.

10
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fig.7.1 - Inserts

WIRE SIZE INSERT COLOUR
0.08 to 0.2 mm? White

0.25 to 0.5 mm? Light grey
0.75t0 1.0 mm? Dark grey

3) Using the wire insertion tool supplied as shown below,
open the clamp contact in the connector shell by pressing
inwards towards the shell.

fig.7.2 - Using the WAGO insertion tool

4) Insert the stripped wire, with or without a PVC insert,
into the hole as shown. If using an insert, ensure that it is
fully seated. Release the wire insertion tool, and check that
the wire is secured. Repeat from Step 2 for all other cores.

201112/lvxHPIM_v1.1
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AUDIO INPUTS

The IntelliAmp is normally* fitted with two transformer-
balanced line inputs. Selection of Input 1 and/or Input 2 as
audio source is made from the WinControl software via the
network, and for most installations only Input 1 need be
wired. However, Input 2 may be connected to a secondary
signal path (in case of a failure elsewhere in the system),
or to an emergency sound source.

Inputs 1 and 2 are available on the 6p male WAGO
connector on the rear panel, but Input 1 is paralleled to a
3-pin female XLR on the front panel; this is usually reserved
for use during a temporary installation set-up, but may
used as the permanent audio input if more convenient.
Audio 1 is also wired to an adjacent 3-pin male XLR,
allowing audio to be looped to further IntelliAmps where
required.

For optimum results only use good quality balanced audio
cable consisting of a twisted pair and an overall screen.
The audio source(s) (e.g. the AXYS® Octadrive) should
have a low impedance balanced output. The nominal line
input level is 0 dBV.

The front and rear panel audio connector pinout is as
follows:

-
] ﬂ:....

»

w @
55 433 72

or

123456

fig.8.1 - Audio input connections

XLR CONN (front)
PIN NO. FUNCTION
1 Line 1 Screen
2 Line 1 +
3 Line 1 -

If the source equipment has a well-designed balanced
output and the wiring strategy shown below is used, there
should be no problems with hum or other extraneous noise.
Note that pins 3 and 6 of the audio connector are analogue
audio grounds, they should be used only for connecting
the screen of the audio cables, and for no other purpose.

LINE 1+
LINE 1 -
LINE 1 SCN

Balanced source
output (e.g. XLR)

IntelliAmp line level
audio input

fig.8.2 - Balanced audio
(Line 1 only shown)

connections

Due to the complex architecture of some large audio
systems, unexpected hum or noise may occur due to
ground loops, or injected noise from other equipment
elsewhere in the system. If this occurs, please refer to the
appendix of this manual and/or the JBL website, where
additional guidance on grounding strategies will be found,
with general techniques that may be applied in order to
reduce ground-induced noise.

WAGO CONN (REAR)
1X70V/100V DUAL 70 V/100 V
PIN NO. LABEL STANDARD VERSION 1 X LINE VERSION VERSION
1 +1 ) Line 1 + 70 V100V + 70 V100V +
Line level 70 V100 V 70 VI100 V
2 -1 audio input 1 Line 1- 70V/100V - 70V/100V -
(0 dBV) input* input*
3 G1 Line 1 Screen GND (n/c) GND (n/c)
4 +2 Line level Line2 + Line level Line + 70V100V +
70 V/100 V
5 -2 audio input2| Line2- | audio input Line - 70 V100V -
input
6 G2 (0dBV)  |Line 2 Screen| (0dBV) Line Screen GND (n/c)

*See footnote on Page 8

201112/lvxHPIM_v1.1
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NETWORK CONNECTION

The rear panel RS-485 network connection should be
wired if the Intellivox system is to be constantly monitored
in operation. The front panel XLR connector provides a
convenient means of uploading the system'’s configuration
file once the installation is complete. Note, however, that
the front and rear RS-485 connectors must not both be
connected to a computer simultaneously. Pinouts of both

connectors are given below.

The RS-485 interface permits multiple units to be “daisy-
chained” in parallel, so that all units are controlled by the
same PC. In such a system, each unit must have its own
unique network address; this is determined via WinControl
for each individual loudspeaker/IntelliAmp pair.

unit 3 unit 2 unit 1

A
B
Y|—
z
D

7 host

DGN

QWw>N<

GND

to other devices

fig.9.1 - Multiple units “daisy chained” in parallel

The network connection should be wired as shown in the
table and diagram below:

Note that 2-pair, individually-screened cable should be
used for RS-485 connection. The transmit (Tx) and receive
(Rx) balanced data lines must be wired via their own
twisted pairs. CAT-5 type UTP or FTP cable is NOT suitable.
Please refer to the Appendix section of the manual for
cable specifications.

fig.9.2 - Network connections

12
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WAGO CONN (rear)

PIN NO. LABELLED FUNCTION
1 A Data Rx +
2 B Data Rx -
3 z Data Tx -
4 Y Data Tx +
5 DG Screen

5 pin XLR (front)
PIN NO. FUNCTION
1 Screen
2 Data Tx +
3 Data Tx -
4 Data Rx -
5 Data Rx +

The maximum cable length over which the network
connection will operate reliably depends on the cable type
and the baud rate used. With good quality cable, a safe
maximum figure is 2000 m. If the distance is significantly
longer than this, a network repeater will be required.

A+
B-
Y+
Z-
DGND
RS-485 port

f tf

network cable
twin twisted
individually

fig.9.3 - Twisted pairs shielded

Further information on the RS-485 network can be found
in the manual for the USB to RS-485 converter and in the
WinControl Help files.

A

be set to a unique network address (determined via

: WinControl).

period of time, ensure that either all devices are switched

Before connecting multiple devices to the same
network subnet, ensure that their network
addresses do not overlap. Each device should

If the RS-485 network is not used (i.e. the RS-
485 converter is disconnected) for a longer

off, or are disconnected from the network.

Alternatively the RS-485 drive lines (host Y and Z in fig. 9.1)
can be shorted or interconnected via a low impedance (e.g.
100 Ohm resistor). Note that in this respect it is also allowed
to interconnect all RS-485 pins (A, B, Y, Z and DGND), the
device transmit pins are always disabled in this case.

201112/lvxHPIM_v1.1
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FAULT MONITORING RELAY CONNECTOR

B rd
“’*_:'---

54321

fig.10.1 - Fault monitoring relay connections

PIN NO. LABELLED USE
1 coM Failure relay Common
2 NO Failure relay Normally Open
3 NC Failure relay Normally Closed
4 +24V +24V
5 Not connected

The pinout of this connector is as follows:

IntelliAmp
24V DC
-1 O Not connected
To external +24V| O—
fault reporting R FAULTNC | O
system FAULTNO | O
~———fAuLT com | O )
Failure
Relay

fig.10.2 Failure relay connections

c The diagram above illustrates how this
connector may typically be wired.
The external fan control is not operational, the IntelliAmp

is equipped with internal temperature-controlled fans.

Please note that Failure Relay and SPL/Temp sensor
connectors are both of the same type, do NOT interchange!

201112/lvxHPIM_v1.1

Fault Monitoring

The IntelliAmp’s internal Failure Relay is energised in
normal operation (COM connected to NC). Power failure
or a pre-defined fault condition causes the relay to release,
when COM will be shorted to NO. External fault monitoring
equipment can be connected to COM and either NO or NC
as required, depending on whether the external system
registers a fault condition as a short-circuit or an open-
circuit. The relay contacts are fully floating (volt-free).

The fault conditions under which the IntelliAmp failure
relay is de-energised are user-definable, and are loaded as
part of the unit's settings file with WinControl.

Status LED

Note that the front panel Status LED mimics the operation
of the failure relay. The LED is green in normal operation,
and goes red when a fault condition arises.
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EXTERNAL AMBIENT SPL/TEMPERATURE SENSOR

The pinout of this connector is as follows:

12345

fig.11.1 - External ambient SPL/Temperature
sensor connections

PIN NO. LABELLED FUNCTION
1 MIC ANS mic +
2 AGND ANS mic -
3 NTC Temp Sensor +
4 AGND Temp Sensor -
5 GND Screen

Although accessed via the same connector, the ANS
microphone and temperature sensor functions are
independent of each other and either or both may be used,
as required. The optional AXYS® combined Ambient SPL/
Temperature sensor is recommended, but either of its two
functions may be used alone if wished.

AMBIENT SPL/ INTELLIAMP
TEMPERATURE

SENSOR

Pair 1 |

AGND O
Shield O
Shield O

fig.11.2 - Ambient SPL/Temperature sensor
connections
The diagram above illustrates how this connector should

be wired to the optional combined sensor using twin
twisted-pair cable with an overall screen. Note that there
are two AGND terminals on both the IntelliAmp and the
sensor; care should be taken not to confuse these, and in
particular, not to connect AGND to GND at any time.
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External Ambient SPL Sensor

The IntelliAmp’s DSP system incorporates an autogain
algorithm which intelligently alters the volume of the
audio according to the ambient noise level. The autogain
function is activated and adjusted via WinControl. The
automatic volume adaptation feature will only give good
results if the signal measured by the sensor's microphone is
truly representative of the diffuse ambient noise level, and
therefore careful consideration needs to be given to the
best location for the sensor. This may well be at a position
remote from the Intellivox loudspeaker itself. It should
not be near direct sound sources such as people talking,
air conditioning system outlets, or other constant noise
sources such as electrical plant, etc. The most favourable
sensor locations are walls or ceilings (height > 3 m) within
the coverage range of the loudspeaker.

Temperature sensor

The external temperature sensor is for activating the
IntelliAmp’s frost detection system, and should be
connected if it is anticipated that the ambient temperature
at the sensor position may drop below 0 °C. If it does,
an internally-generated pilot tone is applied to the
loudspeakers, this warms the voice coils slightly, thus

preventing any build-up of moisture in the magnet gap.

201112/lvxHPIM_v1.1
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LOUDSPEAKER CONNECTIONS

The standard cable supplied with the unitis 5 m in
length. Longer cables are available, and length should
be specified at the time of ordering. The loudspeaker
cables are terminated in Harting multipin connectors,
male-to-female, and wired pin-to-pin. The DC/DS
808 models use 20-pin connectors, the DC/DS 1608
models use a dual version which provides two 20-pin
connectors in a single shell.

The pinout of the Harting connectors is given below:

DC/DS 808 & 1608 DC/DS 1608
upper connector lower connector only
PIN NO. FUNCTION PIN NO. FUNCTION
1 Ch. 1+ 1
2 Ch.2 + 2
3 Ch.3+ 3 Ch.9+
4 Ch. 4 + 4 Ch. 10 +
5 Ch.5 + 5 Ch. 11 +
6 Ch.6 + 6 Ch.12 +
7 Ch. 7 + 7 Ch. 13 +
8 Ch. 8 + 8 Ch. 14 +
9 9 Ch. 15 +
10 10 Ch.16 +
11 Ch.1- 11
12 Ch.2- 12
13 Ch.3- 13 Ch.9-
14 Ch. 4 - 14 Ch.10 -
15 Ch.5 - 15 Ch. 11 -
16 Ch.6- 16 Ch.12 -
17 Ch.7- 17 Ch.13 -
18 Ch. 8- 18 Ch. 14 -
19 19 Ch. 15 -
20 - 20 Ch. 16 -

201112/lvxHPIM_v1.1

CABLE SPECIFICATIONS

Installers wishing to make up their own loudspeaker
cables should ensure that the multicore cables used
have cores of adequate diameter. The maximum
permissible cable length is dependent on the wire
gauge of the cores. Too high a cable resistance,
resulting either from too small a core diameter, an
excessively long cable length, or a combination of the
two, will result in an unacceptable level of signal loss
between the IntelliAmp and the loudspeaker.

The maximum signal loss that can be tolerated before
the performance of the Intellivox is audibly degraded
is 1 dB. The tables below list the cable lengths which
resultin a 1 dB signal loss for various core diameters,
and thus represent the maximum cable length which
can be employed in each case. Installers should
recognise that these are absolute maximum figures,
and work well within these limits.

Note that all cores in the cable must be of the same
wire gauge.

METRIC WIRE SIZES AWG WIRE SIZES

WIRE DIA. M(’?)Z:;EI':SGST)H WIRE DIA. M(?);;Elﬁfs;'"
0.50 mm? 11.6m 22 AWG 7.6m
0.75 mm? 175 m 21 AWG 95m

20 AWG 121 m
19 AWG 152 m
18 AWG 19.2m
17 AWG 242 m
16 AWG 30.5m
15 AWG 38.4m
14 AWG 48.4 m
13 AWG 61.0m
12 AWG 77.0m
11 AWG 97.0m

1.00 mm? 233 m
1.50 mm? 349m
2.50 mm? 58.2m
4.00 mm? 93.1m

More comprehensive data on maximum

cable lengths and calculated signal loss for

other cables types / lengths may be found
on the JBL website.
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MECHANICAL INSTALLATION
OF THE LOUDSPEAKER

Acoustic Centre

Mounting an Intellivox loudspeaker is a straightforward
procedure, but it is essential to understand that the
height of the unit above floor level is extremely critical.
The “correct operational height” is defined as part of the
acoustical design process and the installer should make
sure that he/she has this information before commencing

to mount the Intellivox.

The correct operational height defined by the system
designer is the height of the Intellivox's acoustic centre.
This point coincides with the centre of the loudspeaker’s
lowest driver unit. The location of the speaker’s acoustic
centre is marked by the centre of the yellow sticker on the
front face of the unit at the time of shipping, and it is this
position that must correspond to the operational height
defined in the design process. Note that the horizontal
position of the acoustic centre is on the vertical centre line

of the column.

9905020°-4 924902020
..‘.’ \ \..'..l
... Q\ & “....
R 008
:r$ TOP 6‘0:'
190 This stlc»\er represents é‘.l
( o
( o
; ACOUSTIC o
‘% S .‘.
o>, GENTER _.s8
0o ,2¢®
[ ®/ 64
'.‘:o'?o of this unit S*C;\ ... ‘
.‘..\ 03 3 0 \\\%\ ‘...‘
.....; from gril bl g @ 200020
4 .-.-.‘.'.-.2.. %

fig.12.1 Sticker showing acoustic centre and unit
orientation
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When calculating the positions for the mountings
(see fig 13.1), the distance from the acoustic centre to
the top or bottom of the loudspeaker (whichever is being
used as the reference datum) should be measured and
then allowed for when marking the mounting positions.
The model-specific specification sheet supplied with
each loudspeaker includes a mechanical drawing clearly

showing the mounting position locations.

A

height may cause severe degradation of the expected

Because of the extremely tight vertical
radiation pattern of the Intellivox, a small
deviation from the calculated mounting

acoustic performance. Similarly, the Intellivox should be
perfectly vertical in both planes unless otherwise specified
(see fig 12.2).

A\

Note that the yellow sticker also indicates
which way is “up”; ensure that this orientation
is observed.

L=

fig.12.2 lllustration showing the critical vertical
alignment in both planes
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AXYS® Intellivox 808/1608 Installation Manual Rev 1.1

Mounting Options

The Intellivox loudspeaker has two attachment points at the
rear of the enclosure; the device should be mounted using
these points. Each point consists of four M8 threaded inserts
20 mm deep, and only the hex-head screws supplied with

the original mounting hardware should be used.
There are three options for mounting the Intellivox column:

1. The first (and most often used) method is to use the
standard mounting brackets supplied ready-fitted to the unit.
Dimensions of the bracket are shown in the drawing below.

£ 0
F —
g
$
198
,77O,fﬂ8.2 (4x) o < © ©
g g g
8.2
18 St
i o) fll® a
]

168

fig.13.1 - Standard bracket dimensions in mm

The standard brackets allow mounting of the Intellivox on a
straight wall with a gap of 62 mm (2.5") between the rear
of the enclosure and the wall.

The mounting procedure is given on page 18 under
“Mounting Procedure”.

2. A second method is to mount the Intellivox column using
a pair of (optional) hinge brackets, which allow the plane of
the column's vertical radiating axis to be at an angle other
than 90 degrees to the wall. The hinge brackets are mounted
to the rear of the standard brackets. The hinge brackets
permit the Intellivox to be rotated through 90 degrees, the
direction of rotation being determined by their orientation.
Refer to page 22 for ordering information.
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[ 16 (4x)

fig.13.2 -
Direction of
rotation

when using
hinge brackets

The third method is to mount the column within a recess
in the wall or dedicated mounting panel so that the front
of the unit is flush. This is a specialised mounting situation
which will be encountered only rarely. Access to the rear of
the unit will still be required for the multicore loudspeaker
cable. Depending on the particular circumstances, it may be
appropriate to remove the mounting brackets from the rear
of the unit. If this is done, take great care to protect the rear
of the HF drivers which are normally protected by the lower
bracket.

Because of the proximity of the unit to the walls, particular
attention should be paid to the avoidance of acoustic

resonances (see below).

Cavity walls can sometimes be problematical when high-
power loudspeakers are mounted on them. The internal wall
cavity may resonate at one or more frequencies, degrading
the audio performance significantly. Installers are advised to
insert rockwool or similar sound-absorbing material into the
cavity in the vicinity of the loudspeaker when mounting an
Intellivox on a wall of this type.

An Intellivox Accessories brochure, which includes details of
the optional hinge brackets, may be downloaded from http://

www.jblpro.com.

17



Mounting Procedure

The general mounting procedure using the standard

brackets is described below. It is assumed that the

IntelliAmp has already been satisfactorily installed and

wired in a rack, as described in the previous chapters,

and that the multicore speaker cable has been run to the

loudspeaker location.

Proceed as follows:

1.

18

Remove the upper of the two mounting brackets from
the rear of the loudspeaker by undoing the M8 x 16
hex-head screws securing it (see fig.14).

The four “keyhole”-shaped holes in the rear plate of
the bracket are used to fix the brackets to the wall. Use
of the wall plugs and hexagon head screws supplied
is recommended. If using other types, ensure that
the "across-flats” head size does not exceed 15 mm
(0.6").

Using the bracket removed in Step 1, mark the wall
for the wall plugs. Refer also to the Mechanical
Details drawing in the datasheet supplied with the
loudspeaker. Check the dimensions given from the
reference datum to each pair of mounting holes, and
allow for the offset of the acoustic centre from the
reference to ensure that the acoustic centre will be at
the height defined in the acoustic design specification.
Reference to Fig 13.1 may also be helpful. Drill the
holes (@ 10 mm).

Insert the plugs and screws into the holes. Tighten
the screws with a spanner, but stop with a few mm of
screw shaft visible between the head and the wall.

Check that it is possible to slide a bracket over the
heads.

Check that the chosen mounting points will position
the column in the correct vertical angle specified by the
acoustic design (which is usually exactly perpendicular
to the listening area). Use spacers on one or more of
the brackets if necessary.

AXYS® Intellivox 808/1608 Installation Manual Rev 1.1

6. Next, re-attach the bracket to the rear of the Intellivox

enclosure using the screws and washers removed
in Step 1. Ensure that both brackets are oriented
correctly, with the keyhole slots upwards. Tighten with
a spanner, or with a hex socket using the 16 mm dia.

holes for access for the socket driveshaft.

Q
©)

4
)

o=

fig.14 - Bracket removal/attachment

7. Manoeuvre the Intellivox loudspeaker roughly into

position and plug in the Harting connector of the

speaker cable. Apply the connector retaining lock.

Lift the Intellivox and slide the brackets over the heads

of the hex-head screws protruding from the wall.

Firmly fasten the screws securing the brackets to
the wall. Re-check the verticality (or other angle if
specified) with a spirit level or similar levelling device.

201112/lvxHPIM_v1.1
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4.SYSTEM CHECKS

After installation and connection are complete, the installer
should upload the settings file into the IntelliAmp with
WinControl software. The upload procedure will verify the

system'’s correct operation.

This section of the manual describes the file upload
procedure. It assumes that a laptop (or other computer)
with both WinControl software and a driver for the RS-485
interface already installed is available, together with the
AXYS® (or other suitable) RS-485 interface. It also assumes
that the installer has the settings files, prepared by the
system designer, for each Intellivox loudspeaker making
up the system. These may be elsewhere on the laptop's
hard drive, or may be supplied separately on removable
media such as a memory stick or a CD-ROM. No previous
knowledge of WinControl is necessary, but basic familiarity
with Windows file handling is required.

A full description of WinControl is beyond the scope of
this manual and further information is available in the
application’s Help files. Instructions on how to install
WinControl on a PC are included with the Program Set.
Instructions on the use of the AXYS® RS-485 interface are

included with the interface itself.

CONNECTING THE PC TO THE INTELLIAMP

The PC connects to the IntelliAmp via an RS-485 interface
adapter. (Two versions of adapter are available from
AXYS®, for connecting to PCs either via a USB or an RS-
232 port).

The most convenient method of connecting to the
IntelliAmp is usually via the 5-pin XLR on the front panel.
Use either a 5-pin XLR to 5-pin XLR cable or a 5-pin XLR
to 9-pin Dsub cable. These cables are supplied with the
WinControl Program Set, the type depends on the RS-485
interface type*. Alternatively, the IntelliAmp’s RS-485
network port may be accessed via the rear panel WAGO
connector; (this may be a simpler option in situations
where multiple amplifiers have been interconnected as
all amplifiers may be addressed from a single PC access
point). There is no difference in functionality between

the front and rear panel RS-485 connectors.

The RS-485 interface should then be connected to either
the PC's 9-pin COM port (in the case of a RS-232 to
RS-485 interface) or a USB port (in the case of a USB to
RS-485 interface).

*Cables to connect the RS-485 interface to the Intellivox system may also be ordered separately from JBL — see page 22 for

ordering information.

201112/lvxHPIM_v1.1
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SETTINGS FILE UPLOAD

Apply mains power to the Intellivox, turn on the
PC and launch WinControl. Open Options >
Communications options, and confirm that the Off-
line box is unchecked and that the correct COM port is
selected. Close the Communication options dialogue
box. If the PC is connected to only one Intellivox, a
screen similar to that shown below should now be

H WinControl 2.46 User version

File Wiew Parameters Command Groups Scene Tools Uklities Options Help

B Od S @ Hos o R e W

et configuration
= BE Sublet 00 - COM 4

w001 Intedlivox-DCa0S

Graups

% NIRNIE 4

fig.15.1 - WinControl connected to single unit
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displayed.

The green rectangle in the main pane represents the
Intellivox. The model number is shown below and
the unit's current network address to the right. If a
complete network comprising multiple Intellivoxes is
being accessed, additional similar rectangles will be
displayed.

If the display does not look like that shown, click on
Command > Netscan to force the PC to re-scan the
network. (This will be the case if the Intellivox(es)
were unpowered when WinControl was launched.) If
this fails to produce the correct display, please check
all network connections, and that the correct port on
the PC is selected (open Options > Communications
options to do this).

Select the Intellivox to have its settings file uploaded
by clicking on it once, highlighting its model number
and address, if it is not already highlighted.

AXYS® Intellivox 808/1608 Installation Manual Rev 1.1

Click File > Load settings..., which will open the two

dialogue boxes shown below, Load control parameters

settings and Control parameters.

File Name field

\

Browse button

B Load cunt\Ql parameters settings

NLoE

Settings file
File: name:

- ssarch...

|E:\. LADuran nudio\B\I"LWinContro\ISEttingslva-DCBDSfdeFault.ini M -

File options |Singla file

]

Parameters

Info from File (read-onky)

Default setting Ivie-DCE0E

Beam
Input
Waolume
Delay

EQ

Protected EQ
Autogain
Surveillance
Other

LEEEEEIEEIEE]

Presets

Preset options | Current preset only

Device preset

| Mormal (preset 00
Preset 1 [Lacked]
Preset 2 [Locked]
Preset 3 [Locked]
Preset 4 [Locked]
Preset 5 [Lacked]
Preset & [Locked]
Preset 7 [Locked]

v oK X Cancel

Settings file preset

@ el

fig.15.2 - Uploading the settings

B Control parameters [Normal (preset 0) / Standard]

- B3

Beam ‘Input Yolume | Delay || EQ

Autogain | Surveillance

Other

Main lobe
Active
Relative gain
Elevation angle
Opening angle

Focus distance

a dE

-2.0 deg

0.0 deg

v a0y

20,0 m

Intellivox

Second lobe
Active (]
Relative gain
Elewation angle
Opening angle

Focus distance

v a0y

W Apply X Close

Load... * Save..

Presets -

@ Help

Address -> 001

Mormal (preset 0}

201112/lvxHPIM_v1.1



AXYS® Intellivox 808/1608 Installation Manual Rev 1.1

The File Name field (at the top of the Load control
parameters settings dialogue box) indicates the
last-used settings file name. If this is the first
time that the installation of WinControl has been
used, a default settings file is selected. The default
location for this file is in [My Documents folder]\
Duran Audio BV\WinControl\Settings,
though as this is alterable, it is possible that a different
location may be displayed, depending on how the
particular PC being used has been set up. To navigate
to the location containing the settings file to be
uploaded, click on the Browse button (the folder
symbol to the right of the File Name field), which will
open a further Open dialogue box. Navigation may be
continued in the normal Windows manner. Note that
Intellivox settings files always have an *.ini file

extension.

Select the correct settings file and click Open. Then in
the Load control parameters settings dialogue box,
ensure that the proper parameter groups are selected
and specify the preset(s) to be uploaded, click OK* to
continue. An Info dialogue box will then open showing
additional information, in this box click OK to start the
upload process. This will transfer the pre-determined
Intellivox parameters to the loudspeaker. The Control
parameters dialogue box can now be closed and the
upload is complete.

If there are further loudspeakers on the network to
have their settings files uploaded at this time, the
procedure can be repeated by selecting the next
Intellivox. It is possible to load the same settings file
into several Intellivoxes simultaneously, should the
installation require this. See Addresses and Groups in
the WinControl Help file for more information.

* See WinControl Help files for information regarding further Load options.
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5. APPENDIX

OPTIONAL ACCESSORIES

Listed below are a number of additional components which may be required for an individual installation.

Mating connectors and components for external wiring:

CONNECTOR DESCRIPTION ORDER CODE
Mains power PowerCon® plug 17824103
Audio Input WAGO 6-pin female 17954106
Network WAGO 5-pin female 17954105
Failure relay or Ext SPL Mic/Temp. WAGO 5-pin male 17944105
Strain relief housing for 5-pole connectors 17949195
Strain relief housing for 6-pole connectors 17949196
lvx-DC/DS808 loudspeaker cable with 20 p male/female Harting connectors, 5 m 97920003
Ivx-DC/DS1608 loudspeaker cable with 40 p male/female Harting connectors, 5 m 97870003
WAGO wire inserts (white) for wire dias. 0.08 to 0.2 mm 17949605
WAGO wire inserts (light grey) for wire dias. 0.25 to 0.5 mm 17949615
WAGO wire inserts (dark grey) for wire dias. 0.75 to 1 mm 17949625
WAGO wire insertion tool 17949901
Other installation-related accessories:
DESCRIPTION ORDER CODE
Intellivox hinge bracket 90° 802010 (2 required)
Input PCB assy. with 1 x 70/100 V and 1 x 0 dBV line input 381001
Input PCB assy. with dual 70/100 V inputs 381003
External ambient mic/temperature sensor 97661101
Network Accessories
DESCRIPTION ORDER CODE
Serial interface converter, RS-232 to RS-485 387801
Serial interface converter, USB to RS-485 387802
Program Set (inc. WinControl CD, RS-232 interface, cable) 386601
Program Set (inc. WinControl CD, USB interface, cable) 386602
9-pin female Dsub connector 17223309
Cover for D9 connector 17219109
Adaptor cable, 9-pin male Dsub to WAGO 231, 5 m, to be used with RS-232 interface 97660081
Adaptor cable, 9-pin male Dsub to 5-pin XLR male, 5 m, to be used with RS-232 interface 97660082
Adaptor cable, 5-pin XLR female to 5-pin XLR male, 20 m, to be used with USB interface 79660084
Adaptor cable, 5-pin XLR female to WAGO 321, 5 m, to be used with USB interface 97660080
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COMMON ANALOGUE GROUNDING ISSUES

Correctly connecting the IntelliAmp to ground has several
benefits:

1. Safety. The GND terminal of the Neutric PowerCon®
connector provides a direct low impedance path from
the metal parts of the chassis to ground. Always connect

this terminal.

2. Reduction of RF emission. Although the IntelliAmp
electronics are well shielded and external connections
are decoupled to prevent RF emission from the internal
high speed digital circuits, this protection will not work

properly if the chassis is not connected to ground.

3. RF Immunity. RF currents induced in the signal cables
by external RF fields are effectively shorted to chassis-
ground, provided that the cable screen (shield) is of

sufficiently low impedance.

In addition to the mains ground, the IntelliAmp rear panel
connectors have ground pins marked in 3 different ways.
Each serves a dedicated purpose and care should be taken
that they are not interchanged or connected to each other.

e Pins marked GND are connected internally directly to
the chassis of the IntelliAmp. There are GND pins on
the audio line input connector and the ambient SPL
mic/temperature sensor connector. These GND pins
are for connecting the screen (shield) of the audio and
sensor cables.

e Two pins marked AGND are fitted to the ambient SPL
mic and temperature sensor connector, and serve as a
signal reference only. AGND should not be connected

to any other ground pin (GND or DGND) on the chassis.

e The RS-485 connector has one pin marked DGND and
is intended as a terminal for the network cable screen
(shield). Since the RS-485 interface is optically isolated
(to prevent ground loops), DGND has no relation to the
chassis ground. DGND should not be connected to any
other ground pin (GND or AGND) on the chassis.
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SOFTWARE AND FIRMWARE UPDATES

The AXYS® WinControl application is freely available
and can be downloaded from the download area of our
website; http://www.jblpro.com. We advise installers,
users and engineers to check our site regularly for updates.
Intellivox firmware and DSP software upgrades will also be
made available through the website.

For further information about how to use WinControl

please refer to the WinControl Help files.

NETWORK CABLES

The type of cable necessary for correct operation of the RS-
485 network is twin twisted pair with each pair individually
shielded. Numerous cables of this type are readily available
and cables broadly meeting the specifications of the
example cable given below are likely to be suitable.

Example of a preferred cable type:

PARAMETER VALUE

Type BELDEN ‘Datallene' series
No. 9729 2-pair

Characteristic impedance 100 ohms

Capacitance (core to core) 41 pF/m

Capacitance (core to screen) 72.5 pF/m

DC resistance (core) 78.7 ohms/km

59.1 ohms/km

DC resistance (screen)
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